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XF2 Data Controller – Enable Internal GPS Module 
Part Number 874-0305-000 Released: February 13, 2013 

 
 

Overview 
This document describes how to enable and use the internal GPS module in the XF2 data 
collector. It describes how to select the COM Ports and Baud rates to output GPS data from the 
XF2’s internal GPS module to software programs installed on the XF2 data controller that can 
include the u-Center Mobile GPS Evaluation software and the Carlson SurvCE software. 

 
 
 

Equipment and Software Required: 

• Hemisphere GNSS XF2 Data Collector, Part Number: 940-2097-000 

• Carlson SurvCE software, Part Number: 750-2008-000 

• u-Blox u-Center Mobile software 
 
 

The free ublox Mobile Terminal Application – GPS Evaluation software can be downloaded from 
the following link: http://www.u-blox.com/en/evaluation-tools-a-software/u-center/u-center-  

 
 

Unzip and install the ublox mobile u-Center software onto the XF2 using the USB cable and 
Windows Mobile Device Center software. 

 
 

The Carlson SurvCE software can be downloaded from the following link: 

http://www.hemispheregps.com/Products/SurveyConstruction/S320LandingPage/tabid/640/Defau
lt.aspx 

 
From the S320 Landing page, the SurvCE software can be downloaded from the Resources, 
XF Series Data Collectors area. 

 
§ SurvCE Software Download for XF2 (English and Spanish) 

 
For the XF2 Data Collector, download the file: XF2_SurvCE_ENG_SPA.zip 

 
Unzip and install the Carlson SurvCE software in the preferred language onto the XF2 using the 
USB cable and Windows Mobile Device Center software. 
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Procedure 

 

Screenshot or Graphic Step 
 

 

1. Press the Power button the XF2 data 
collector, turning the XF2 unit On, 

2. From the Windows Mobile Desktop, 
tap/select the Windows Start icon on the 
lower left corner of the task bar, 

 

 

3.   From the Start menu, navigate to the 
Settings icon, tap/select Settings, 

 

 

4.   From the Settings menu, navigate to the 
System icon, tap/select System, 
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Screenshot or Graphic Step 
 

 

5. From the System menu, navigate to the 
External GPS icon, tap/select External 
GPS, 

 

 

6. From the GPS Settings menu, select the 
<Access> menu, 

7. Activate the [X] Manage GPS 
automatically (recommended) option, 

 

 

8.   From the GPS Settings menu, select the 
<Hardware> menu, 

From GPS hardware port: (none) option, 
tap/select the down-arrow to reveal the 
COM port options, 
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Screenshot or Graphic Step 
 

 

9.   From the GPS Hardware port: 

COM port options, tap/select COM3, 

 

 

10. From the GPS Hardware port: 

Baud rate: option, tap/select the down- 
arrow to reveal to Baud rate options, 
select 9600, 

 

 

11. GPS Settings 

<Hardware> 

GPS hardware port: COM3 

Baud rate: 9600 
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Screenshot or Graphic Step 
 

 

12. From GPS Settings menu, select 
<Programs> menu, 

From GPS program port: (none), 
tap/select the down-arrow to reveal the 
Port options, 

 

 

13. From the GPS Program Ports options, 
tap/select COM6 

 

 

14. GPS Settings 

<Programs> menu 

GPS program port: COM6 
 
 

Tap/Select the OK button on the task bar. 
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Screenshot or Graphic Step 
 

 

15. User is returned to the System menu, 

Tap/Select the (X) icon on the task bar. 

The user will be returned to the Windows 
Mobile Desktop. 

This completes the required steps to 
enable the internal GPS module on the 
XF2 data controller. 

 

 

The following steps describe how to 
view GPS satellite data and record log 
files in the u-Center Mobile software. 

The following steps presume the u-Center 
Mobile software has already been 
installed on the XF2 data collector. 

1.   From the Windows Mobile Desktop, 
tap/select the Windows Start icon on the 
lower left-corner of the task bar, 

 

 

2.   From the Start menu, navigate to the 
u-Center Mobile icon, tap/select 
u-Center Mobile, 
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Screenshot or Graphic Step 
 

 

3.   U-Center Mobile 4 splash screen, 

 

 

4.   From the u-Center Mobile 4 software, 

From the task bar menu along the bottom 
of the display, tap/select RX menu, 

The RX menu will pop-open, 

Tap/Select Port > 

 

 

5.   From the Port > menu 

Browse the Ports list, select COM6 
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Screenshot or Graphic Step 
 

 

6.   From the u-Center Mobile 4 software, 

From the task bar menu along the bottom 
of the display, tap/select RX menu, 

The RX menu will pop-open, 

Tap/Select Baudrate > 

 

 

7.   From the Baudrate > menu, 

Browse the list, select 9600 

 

 
 
 

8.   The u-Center Mobile software will connect 
to the internal GPS module in the XF2 
data controller. 

The user should observe live/active GPS 
data being displayed in SV Summary 
menu. 

Note the Green (active) connection icon 
on the task bar. To disconnect from the 
internal GPS module, tap on the 
connection icon on the task bar. The 
connection icon will separate, disconnect 
from the internal GPS module. To restore 
the connection, simply tap on the 
connection icon again. This will refresh 
the display. 
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Screenshot or Graphic Step 
 

 

9.   From the u-Center Mobile software, 

From the task bar menu along the bottom 
of the display, tap/select View menu, 

The View menu will pop-open, 

Browse the list, select Text Console, 

 

 

10. Example Text Console display, 

The current GMT time with corresponding 
NMEA message sentences are displayed. 
The NMEA messages include: 
GSA,GSV,GLL,ZDA,GGA and VTG. 

 
 

To change the View, tap/select View on 
the task bar menu, select SV Summary, 
or select other available views, 

 

 

11. To capture Log Files from the internal 
GPS module in the XF2, tap/select File 
from the task bar menu, 

Note, the Log files consist of a series 
of NMEA messages output by the 
internal GPS module. 

12. From the File menu, browse the list, 
select New… 
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Screenshot or Graphic Step 
 

 
 
 
 
 
 

13. New File configuration menu, 

Name: S/w automatically names the file: 
COM6_MMDDYR_GPS Seconds of the 
Week format. The filename can be 
change by the user if required. 

Folder: tap down-arrow to select Folder. 

Type: u-blox Log Files (*.ubx) 

Location: Select from options: 

Main memory or Storage Card 

Note: If Storage Card option is selected, 
the user must insert a Micro SD-Card into 
the XF2 battery compartment. 

Tap/Select Save 

Log File is opened and stored in specified 
folder location. 

 

 

14. From the SV Summary display, note the 
Green connection (Active) icon and the 
Record File icon on the task bar. 

 

 

15. To stop the data collection, close the Log 
file, on the task bar tap/select Play 

Browse the list, select Stop. 

Alternatively, the user can also tap/select 
the Play icon on the task bar, toggling the 
icon to Stop. 
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Screenshot or Graphic Step 
 

 

16. From the SV Summary menu, 

Note the u-Center Mobile is still 
connected to the internal GPS module 
green (active) connection icon, but the 
software is not currently logging a file; the 
red circle icon is displayed on the task 
bar. 

To start a new Log file, tap the Red circle 
icon on the task bar, the new file menu 
will be displayed to the user, tap/select 
Save, a new log file will be opened, 
NMEA messages recorded into the log 
file. 

 

 

17. To exit from the u-Center Mobile software, 
tap/select File, browse the list, select Exit 

18. The user is returned to the Windows 
Mobile Desktop. 

19. If needed, the u-Center Mobile Log files 
can be copied from the XF2 data 
controller to the office PC using USB 
cable and Windows Mobile Device Center 
software. 

 

 

1. The following steps describe the steps to 
output data from the XF2’s internal GPS 
module to the Carlson SurvCE software. 

The following steps presume the Carlson 
SurvCE software has already been 
installed on the XF2 data collector. 

2. From the Windows Mobile Desktop, 
tap/select the Windows Start icon on the 
lower left-corner of the task bar, 
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Screenshot or Graphic Step 
 

 

3.   From the Start menu, navigate to the 
SurvCE icon, tap/select SurvCE, 

 

 

4.   Carlson SurvCE splash screen, 

 

 

5.   From the File menu, 

Select from the two available options, 

Continue Last Job 

Select New/Existing Job, 
 
 

In this Example, choose: 

Tap/select Select New/Existing Job 
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Screenshot or Graphic Step 
 

 

6.   From the Coordinate Files menu 

Tap/Select into the Name: template, 

 

 

7.   The virtual keyboard will pop-open, 

Using the stylus, tap into the Name 
template, enter a new job name, when 
finished entering a suitable job name, tap 
the green check mark, the virtual 
keyboard will close. 

 

 

8.   From the Coordinate Files menu, 

Name: XF2-Internal-GPS 

The name of the new job has been 
entered, tap the green check mark again, 

 
 

Select the Linear Units for the new job. 

In this example: Metric was selected. 
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Screenshot or Graphic Step 
 

 

9.   From the Job Settings | System menu, 

Projection: tap/select the down-arrow to 
select a previously used Projection. 

If the Projection you need is not available 
from the drop-down menu; tap/select on 
the Edit Projection List, then tap/select 
the Add Predefined menu button, set the 
Country: (in this example) USA/NAD83, 

Browse the list of States/Zones, select the 
Projection needed for your project, then 
tap/select the green check mark. 
Tap/select the green check mark again to 
save the Job Settings. 

 

 

10. User is returned to the SurvCE main 
menu, 

11. Select the Equip | 3 GPS Rover menu, 

 

 

12. From the GPS Rover | Current menu, 

Select the following options, 

Manufacturer: NMEA GPS Receiver 

Model: defaults to NMEA GPS Receiver, 
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Screenshot or Graphic Step 
 

 

13. From the GPS Rover | Comms menu, 

Select the following options, 

Type: Cable 

Port: COM 6 

Baud: 9600 Parity: None 

Stop Bits: 1 Data Bits: 8 

 

 
 
 

14. From the GPS Rover | Receiver menu, 

Select the following options: 

[Unknown] Unknown 

(•) Vertical 

This sets the antenna model for the GPS 
Rover. In this case, it’s best to select the 
Unknown GPS antenna model. The GPS 
antenna is an internal antenna inside the 
XF2 data collector. 

Tap the Green check mark to accept 
these settings and continue… 

 

 

15. Configuring rover display… 

Connected to NMEA GPS Receiver 
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Screenshot or Graphic Step 
 

 

16. User is returned to the Equip menu 

17. Select Equip | 5 Configure, 

 

 
 
 
 

18. From the Configure | General menu, 

19. Un-check the option for Store Fixed Only 
(GPS). 

This setting applies only for RTK 
surveying, when the user only wants to 
store Fixed RTK measurements. 

When using the Internal L1 only GPS 
module, (NMEA GPS Receiver), the 
accuracies will be at Autonomous GPS 
level, not differentially corrected. 

Set No. Readings to Average for GPS: 1 

Tap the Green check mark to save 
settings and continue. 

 

 

20. User is returned to the Equip menu 

21. Select Equip | 8 Tolerences, 
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Screenshot or Graphic Step 
 

 
 

22. From the Tolerances menu, 

Set reasonable HRMS, VRMS and 
Stakeout Tolerances for the NMEA GPS 
Receiver equipment currently being used. 

In this example, 

HRMS Tolerance: 3.000 m 

VRMS Tolerance: 5.000 m 

Stakeout Tolerance: 3.000 m 

Note: the RMS values may not be 
available from the currently selected GPS 

Tap the Green check mark to save 
settings and continue, 

 

 

23. User is returned to the Equip menu, 

24. Select Equip | 7 Monitor/Skyplot, 

In this menu, the user will be able to 
confirm the NMEA GPS Receiver is 
sending data into SurvCE; the user can 
view the Quality, Position, SATView and 
SATInfo menus to confirm the NMEA 
data streams. 

 

 

25. From the Monitor/Skyplot | Quality 
menu, 

The Status: Autonomous 

Latency: 0 Date: 12/03/2012 

Satellites: 4/11 Time: 16:27:53.0 

Local Northing, Local Easting, Local Elev 

HDOP, TDOP, VDOP, GDOP, PDOP 

HRMS: N/A 

VRMS: N/A 
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Screenshot or Graphic Step 
 

 

26. From the Monitor/Skyplot | Position 
menu, 

The Latitude, Longitude and Ellipsoid Elev 
are coordinates displayed. 

Local Northing, Local Easting and Local 
Elev coordinates are displayed. 

Selected Projection is displayed. 

 

 

27. From Monitor/Skyplot |SatView menu, 

The currently tracked GPS SV’s are 
displayed in a Sky Plot view. 

The Sat S/N (Signal to Noise Ratios) are 
displayed. 

 

 
 
 

28. From the Monitor/Skyplot | SATInfo 
menu, 

The Individual PRN, SV Type, Azimuth, 
Elev and S/N Ratio are displayed. 

SV’s depicted with an asterisk * are above 
the Elev Mask Angle and being used. 

All four of these menus confirm the NMEA 
GPS receiver data is being sent into 
SurvCE. If there is no data displayed in 
these menus, check/verify the NMEA GPS 
Receiver Port and Baud Rate settings in 
the Equip | GPS Rover menu. 

Tap/Select the Orange Left arrow 
(Return) button in the upper right corner. 
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Screenshot or Graphic Step 
 

 

29. The user is returned to the SurvCE main 
menu, 

30. The user can start collecting data, 

31. Select Survey | 1 Store Points, 

 

 
 

32. From the Store Points menu, 

Enter a starting PT: number 

Enter a Description: 

Leave the HT: 0000 m 

When ready to Store the Point/Feature, 

Tap/Select the [S], or Store button, 

Continue storing Points/Features as 
needed, 

When finished Storing Points, tap/select 
the Red [X] button in the upper right 
corner of the menu, 

 

 

33. If the user wants to store a continuous 
line or trajectory, 

34. Select Survey | 6 Auto by Interval 
menu, 
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Screenshot or Graphic Step 
 

 

35. From the Auto Store by Interval menu, 

Select from the two available options: 

Distance or Time method, 

 

In this example, to get best data 
coverage, select the Time option 

Enter a 1-second time interval, 

Enter a Starting PT ID and Description, 

Tap the Green check mark to save 
settings and start the Auto Store, 

 

 
 
 
 
 

36. From the Auto INTVL menu, 

Note the Green [>] icon, this indicates the 
Auto INTVL is active, storing points every 
second… 

Points stored are displayed in the Map 
view screen, 

Tap the [C] icon, or Configure to control 
what information is displayed in the Map 
View, 

To stop the Auto INTVL Store Pts, 
tap/Select the Green [>] arrow, this will 
stop the Auto INTVL Store Pts, it will 
toggle the icon to a Red [■] 

 

 

37. From the Auto INTVL menu, 

If the Red [■] icon is displayed, no Auto 
INTVL points are being stored. 

To start the Auto INTVL again, tap/Select 
the [■] icon again, it will toggle the icon to 
[>] again, resume storing Auto INTVL 
points again. 

If the user is finished storing Auto INTVL 
points, tap/Select the Red [X] in the upper 
right corner of the menu. 
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Screenshot or Graphic Step 
 

 

38. User is returned to the main menu, 

39. To exit SurvCE, select File | 0 Exit, 

 

 

40. SurvCE confirmation message, 

Are you sure you want to exit? 

Select Yes or No 

 

In this example, Yes was selected, 

The user is returned to the windows 
Mobile Desktop. 

 

 

The data files from the SurvCE software 
can be copied from the XF2 to the office 
PC using the USB cable and Windows 
Mobile Device Center software. 

The SurvCE data files can be found on 
the XF2 \Program Files\SurvCE\Data 
folder. 

Files to copy: CurrentJobName with file 
extensions: .crd,.inf, .ref, .rw5, .sys 
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Further Information 
The Precision Products Technical Support team in Scottsdale has coordinated defining these 
Quick Reference Guides. You can contact Precision Products Technical Support at 
techsupport@hemispheregnss.com for further information. 
This document is provided for technical support purposes only. Refer to the product documentation for warranty, 
license, and safety information associated with the product. 

 
 

Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


